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KCD Software 

 

With our powerful yet easy to use software you can increase and simplify your 
business. From concept to design through production, our software gives you tools 
you need to save time, reduce errors and increase productivity.  

After you have reviewed the software, call to schedule a walk though. During your 
walk through we will give you detailed information on what KCDw software can do 
for your business, and answer any question you may have.  Call us today to schedule 
your walk through. 

 

 
 

 

 

 

 

 

 

Phone: 508-760-1140 
Fax: 508-760-1143 

email us at KCDwInfo@KCDw.com 
home page: http://www.KCDsoftware.com 

 
 

 
Installation 

 

1. Place the CD into your drive. The auto load should appear within one minute. 

• If the auto load does not appear, click on your computer’s Start menu and 
select Run. 

• Type the drive letter of your CD drive, generally D or E, followed by a 
colon and the word setup. (for example:  D:setup) 

2. Read and accept the agreement terms. 

3. The set up will lead you through the rest of the installation. 
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Main Screen 

 

Open the program using the KCD icon that has been installed to your desktop. The main 
screen will appear. Noted are the basic areas of the screen to help you navigate. 

 

 
 

1. Menu Bar – Selections from the menu bar will give you access to more detailed 
commands. 

2. Tool Bar – Quick access to common commands and tools. 

3. Workspace – Area in which projects are built. There are several different views 
from this area including: Floor plan, Elevation, and 3-D.  

4. Library – Drop down menu to select current library set, Including: Frame, 
Frameless, Overlay Frame, Closet and Accessories. 

5. Units Menu – All the individual elements of your cabinet or closet design based 
on the library selected. 

6. Number Area – Size and/or angle of units and walls. This value will change when 
you are dragging a unit or wall to size or place. 

7. Quick Help Bar – displays tips and hints while you work. 
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Libraries and Setting Shop Standards 
 

Before you begin your design, you will want to customize the software by setting 
shop standards, which are the default sizes for cabinets and other objects within your 
project.  Standards can be set for each Library (available libraries include: Frame, 
Frameless, Overlay Frame and Closet).  

Frame and Overlay Frame cabinets have similar questions, a difference being how 
the doors overlay the cabinets.   In frame the doors are sized from the opening 
(Door Lip).  The door would be larger or smaller, by a fixed value, then the opening.  
For example, a 12 by 20 opening would have a 12½ by 20½ door (with ¼” Lip). 

In overlay frame or frameless, the doors are sized from the outside edges of the 
cabinet.  The doors use reveals, which are the amount of cabinet frame or box that is 
exposed when the door is closed.  For example, a 21 by 30 cabinet would have a 
20½ by 29½ door (with ¼” reveals). 

 
  NOTE:  Any changes made to shop standards do not affect an existing 

project. Standards should be set prior to beginning your design.  We suggest 
that you scroll through the entire list of standards, to better acquaint yourself 
with the many choices available. 

1. Start by clicking on Library in the menu bar. 

2. Select the library for the standards you want to set.  A checkmark will appear 
beside your selection and the menu will close. 

• Frame - This library contains elements for the design of face frame 
cabinetry. When accessing the parts list while using this library, you are 
accessing the face frame parts list. 

• Frameless – This library contains the elements for designing European, 
or frameless, cabinetry. When accessing the parts list while using this 
library, you are accessing the frameless parts list. 

• Overlay Frame – This library contains the elements for designing overlay 
frame cabinetry. When accessing the parts list while using this library, you 
are accessing the overlay frame parts list. 

• Closet - This library contains the elements for designing closet cabinetry. 
When accessing the parts list while using this library, you are accessing 
the closet parts list. 

• Accessories - This library has items to enhance the look of your design; 
items such as house wares, office equipment, lighting, furniture, and 
ceilings.  

 NOTE:  By default each library uses a specific color group and counter top 
group. However, any color or counter top can be applied to a wall or unit. 
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3. Click on Change in the menu bar. 

4. Select Set Shop Standards from the drop down menu.  

5. Click on the value you would like to change and enter the new value.   You 
can scroll thru the menu using either the up and down arrow keys, or with 
your mouse on the scroll bar. 

 

 
 

 

 

You can change the 
standards on a project-by-
project basis.  Making 
customization easy. 

You can set the standards so 
that each new project uses 
the same measurements. 

Scroll Bar 

Measurement 
Value 

Measurement 
Description 
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Adding and Positioning Walls and Islands 
 

Once you have set your shop standards, you are ready to begin your design. The 
first step is to add walls to your project workspace. Adding and positioning walls sets 
the stage for your project design. 
 

Adding a Wall 

1. Click Add Wall.  A grid will appear.  (This is your room)  

2. Place your mouse pointer anywhere on the grid and hold down the left 
mouse key to drag your wall into place. Look in the lower right hand number 
area for sizing information. 

3. The Add-Change Wall box will appear.  From here you can customize your 
wall settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 N
OTE:  To toggle between the Floorplan view and Elevation view, press Space 
Bar twice.  When re-positioning or angling walls you must be in the 
Floorplan view.  (The back of the wall is the side with the dimension line on 
it.) 

 

Repositioning a Wall 
1. From the Floorplan view, place the mouse pointer on the center of the wall.  

2. Hold down the left mouse button (the mouse pointer will turn into cross 
arrows). 
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3. Drag the wall to a new position on the room grid and release the mouse 
button. 

 

Changing the Angle of a Wall 
1. From the Floorplan view, place the mouse pointer on the left or right end of 

the wall.  

2. Hold down the left mouse button (the mouse pointer will turn into cross 
arrows). 

3. Drag the end of the wall to change the angle on the room grid and release the 
mouse button. 

• While dragging, look in the lower right hand number area of the screen for 
the wall angle information. 

 

 

NOTE:  You can remove a cabinet or wall from the project workspace, by 
dragging the object to the trash bin in the lower left corner of the project 
window and release.  You can retrieve an item from trash bin with in the same 
session by pressing Ctrl Z or UnDo.  

Adding an Island or Peninsula 
Islands and peninsulas are the same as walls, with a few exceptions. They are 
invisible in the 3D view and have no thickness or depth.  They are denoted on 
the floorplan view by a dotted line. The most notable difference from a wall is 
that cabinetry can be place on the front and back of an island or peninsula; 
however they can be angled and repositioned in the same manner as a wall. 
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1. Click Add Island.  

2. Place your mouse pointer anywhere on the grid and hold down the left 
mouse key to drag your wall into place. 

3. The Add-Change Wall box will appear.  From here you can customize 
your wall settings. 
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Customizing Walls and Islands 

 

All new walls follow the shop standards that have previously been set. However 
once a wall is added, it can be customized at anytime during your project. Settings 
such as height, length, thickness, and color can all be modified from the Add-
Change Wall box.  When a wall is placed on the project workspace it is assigned a 
number.  These numbers are assigned in the order the walls are created.  

 
Changing Wall/Island Settings 

To open the Add-Change Wall box, place the mouse pointer on any wall and 
double click.  To change any value on the Add-Change Wall box, click in the box 
with the value to be changed and type in the new value.  Once you have 
completed your changes, click on the OK button and the changes will be applied. 
 
Wall Length – Length of wall. 

X Location – Position of the front left, lower 
corner, going left to right. The higher the X value 
the farther from the left of the screen. 

Y Location – Position of the front left, lower 
corner, going top to bottom. The higher the Y 
value the farther from the top of the screen. 

Angle – Changes the wall’s angle. 

Wall Height – Height of the wall from floor to 
ceiling. 

Island –Peninsula – Checking this box changes 
the wall to an island/peninsula. 

Less/More – This button hides/reveals additional 
fields located below the Room Name and Number 
fields. 

Wall Name & Number – Label for the current 
wall. You can cycle though the walls within the 
room by using the up and down arrows next the 
number box. 

Room Name & Number – Label for the current 
Room.  If you change the room number, the wall 
and any units attached to it will be added to the 
room indicated. 

Flip Wall 180 Degrees – Flips the wall with all its 
units, while maintaining its position within the 
workspace. 

Change Length on – Which end of the wall will 
extend or retract with a change in length. 

Thickness – Thickness of wall. 
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Top/Base # Depth – The measurement that a cabinet can be located from the 
wall, and still show on the elevation view. Cabinets located outside this 
limit will not appear in the elevation view.
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Accessing the Back of an Island-Peninsula 
In the floorplan view cabinets can be placed on both sides of the dotted line that 
denotes and island or peninsula.  When in the elevation view there are 2 ways to 
make the back of the island active.  

• In the elevation view, from within the dotted line, click the right mouse 
button to activate the back of the island. Clicking the left mouse button will 
toggle you from back to front of the island. 

• Press B on your keyboard and the wall number assigned to the island.  This 
action only works for islands numbered 1-9. 

 

Locating and Sizing Units on Walls  
 

Once you have placed and sized your wall(s), you are ready to add units to them. 
From the Unit Menu chose a category.  To expand and collapse the specific elements 
within the menus click on the + / - button next the category heading.  You can view 
the specific Unit before adding it to the wall. Place you 
mouse pointer on the Unit you want to view and hold down 
the left mouse button. 

 

The selected library will determine the individual Units 
available.  Units will be placed on the active wall.  Select an 
element by clicking once on it.  When an element is selected 
it will be highlighted in blue.  

Adding a Unit (Click + 
Drag) 

The new unit will be assigned a number based on the 
order in which it is added to the project.  Like walls, 
units can be customized at anytime during your design 
process.  

1. Select the desired Unit by clicking once on it. 

2. Place the mouse pointer anywhere on the active 
wall.  Press and hold the mouse button, and drag 
the unit to the desired size. 

3. When creating a unit by clicking + dragging, the 
mouse pointer can be used to increase or decrease 
the size of the unit.  When increasing the unit size 
using the mouse pointer, the pointer will move 
quickly, closely following the pointer movement.  
When decreasing the unit size, the mouse point 
follows movement more slowly to allow for precision sizing. 

 

Library Selection Menu 
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4. The unit will appear as a dotted outline, and the Add Unit box will open.  
From here you can customize your Unit sizes. 

 
 NOTE:  You can toggle between the floorplan and elevation view.  From the 

floor plan view double click the left mouse button within the workspace, but 
not on a wall or unit.  From within the elevation view double click the left 
mouse button within the workspace, but not on a wall or unit. 

 
Repositioning a Unit 
Units can be repositioned from either the floorplan or elevation views. They can 
also be reposition to a different wall. 

1. Place the mouse pointer on the unit number and hold down the left mouse 
button.  

2. Drag the unit to the new location and drop it into place by releasing the 
mouse button.  Remember units can be dragged to a different wall if desired. 

• Look in the lower right hand number area of the screen for location 
information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 NOTE:   Unit numbers are assigned by the software in the order in which the 
units are added to the design.  

 

 
  

Unit Number 
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Customizing Units 
 

Units, like walls are completely customizable. Their sizing and style can be changed to 
fit your design. KCDw software provides you the tools to make your vision come to 
life.  Once you have placed your units on a wall, you can access Units that will allow 
you to customize the doors and add handles, pulls and hinges from our extensive 
design library. 

 

Sizing an Existing Units 

To open the Change Unit box, place the mouse pointer on any unit number and 
double click.  To change any value on the Change Unit box, click in the box with the 
value to be changed and type in the new value.  Once you have completed your 
changes, click on the OK button and the changes 
will be applied. 

 

The graphic is an example of values within the 
unit box.  These values change depending on 
the unit type selected.   

 

Joining Multiple 
Units 
To join two units by clicking and dragging, 
simply overlap the new unit onto the existing 
unit and the two units will be automatically 
joined. (Overlap about 5” in the scale of the 
drawing.) 

To join two existing units, open the Change 
Unit box by double clicking on the unit 
number.  Set the left or right stile value to 0. 
(Be sure to set the stile on the proper side of 
the unit to zero.) 

 NOTE:  Parameters preceded by “ !! ” can 
be toggled between 0 and the shop 
standard by double clicking on the “  !!  ”. 
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Door Styles 
 

KCDw software allows you to customize the door style for your design. You can 
change them using the menus or using keyboard and mouse short cuts.   To open the 
Door Style box, select Doors from the main menu. Click on Change All Doors, or 
press Ctrl D.  

 

Change All Doors 

1. Open the Door Style box. 

2. Hold the mouse button and drag the selected door to the “Doors on This Job” 
section and drop on the top or base door. 

3. Hold the mouse button and drag the selected drawer style and drop on the 
drawer front. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 N
OTE: Extra doors are used when changing 1 door.  The extra door selections 
can be changed by holding the mouse button and dragging the selected door 
to the “Extra Doors” section and dropping on one of the available slots. 

Change a Door Using Shortcuts 
1. Place the mouse pointer on the door to be changed. 

2. Hold the Ctrl key and click the left mouse button.   This action will cycle you 
though the selected door styles from “Doors on This Job” and “Extra Doors” 
sections, plus one additional selection of No Door. 
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Change One Door Menu 

1. Select Doors from the main menu. Click on Change 1 Door, or 
press Ctrl F. 

2. Enter the number of the unit to be changed in the Unit #.  
3. Enter the opening number.  For example a base cabinet with 

one drawer on top and doors on bottom, the drawer is opening 
1. 

4. Select the door style to be applied and press Make Change.  

 

 NOTE: 0 represents no doors, 1 and 2 is the top and bottom 
door style defined in the “Doors on This Job” section of the 
Door Style box, 3 represents the Drawer Front style, and 4 – 9 
represent the “Extra Doors”. 

 

Adding Handles  

1. Open the Choose Handles Types & Location box, Press Ctrl H 
or select Add Handles & Hinges from the Doors Menu  

2. Select the handle types and placement for top and base doors and drawer 
 fronts. 

3. Press OK to apply changes. Handles will be added to all doors types for which 
handles have been chosen. 

 

 

 

 

 

 

 

 

 

 

 

 

 NOTE:  
Once you have Choose Handles Types & Location the handles, knobs, and 
hinging   will be visible in the elevation view. 
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Changing Handles 
The style and position of a single handle can be changed using shortcuts from 
within the elevation view.  

• To change the handle style, place the mouse pointer on the handle to be 
changed.  Hold down the Shift key and click the Right mouse key.  This 
action will cycle through vertical, horizontal and knob handles, as well as no 
handle. 

• To change the handle position, place the mouse pointer on the handle to be 
changed.  Hold down the Shift key and click the Left mouse key. Then still 
holding the Shift key, click to the position you want to place the handle. 

  NOTE:  There are 9 positions for door handles; top, middle and bottom on 
the horizontal and left, center and right on the vertical.   There are 6 positions 
for drawers, top, middle and bottom on the center and dual knobs or handles.  
For example: 

 

 

 

 

 

 

 

 

 

 

Changing Hinges 
Hinges are defined by dotted lines, which note how the door or drawer will open. 

• To change the hinge placement, place the mouse pointer on the dotted line 
representing the hinge to be changed.  Hold down the Ctrl key and click the 
Right mouse button on the side of the door that the hinge should be placed. 

 NOTE: The doors on a unit can be made into a door pair.  In door pairs, 
changes applied to one of the pair are applied to the other door in the pair 
automatically.  Door pairs can be made using either the Change Unit box or 
the Change 1 Door box. (Remember Ctrl F also opens the Change 1 Door 
box.) 
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Colors and Textures 
 
Colors, textures and materials can be changed to enhance the look of your design.   
The ability to customize every aspect of your design is one of the ways that KCDw 
Software can increase your productivity, while simplifying your process.  Changes to 
Colors, textures and materials are accessed while in the 3D view. 

 
Accessing 3D View 
The 3D view gives you a beautifully realistic view of your design. It allows you to 
maneuver within your design to any angle.  You can zoom in close to a single unit 
or pull back to view the overall placement and look of the design.  The 3D view 
can be access from the menu bar.  The 3D View box will appear. 
 
Move Camera – Changes the perspective of the view.  Think 
of yourself as the camera. 

• Up/Down changes the perspective as if the camera 
were being elevated or lowered from within the room. 

• Forward/Back changes the perspective as if the 
camera were being move into or away from the room. 

• Left/Right changes the perspective as if the camera 
were being angled in one direction or the other. 

Move Picture – Changes the placement of the entire image 
within the frame. 

• Up/Down will change the placement of the image 
higher or lower with in the frame. 

• Left/Right changes the placement of the image to one 
side or the other of the frame. 

Size Picture – Enlarges or shrinks picture based on a default 
of 100%. 

Hide Me – Closes the 3D View box. The box can be re-
opened by pressing 3D from the menu bar. 

Return to 2D – Returns you to the floorplan view. 

Birds Eye View – Changes the perspective to above the room, as if the camera 
were on the ceiling.  (This view will not make a Photo Realistic Rendering.) 

Default View – is a 3D view of the elevation view.  Unit numbers are still visible 
from 
 within this view.  Changes to unit sizing and position cannot be made while in 3D 
view. 

View Presentation – This shows you the 3D image with colors and texture 
applied.  You can switch between View Line Drawing and Presentation View by 
pressing this button. 

Options – Opens the options menu. 
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Help and 3D Photo Tips – Access the help menu and gives additional 
information on using features within the 3D view. 

 

Customizing Colors 
Color can be changed or added for most items with in your design, including 
walls, floors, appliances, counters, and units. Depending on the units you are using 
in the design, frame, frameless, or frame overlay, there is a default color group 
assigned. These default colors can be modified to suit you overall design. Unit 
colors can be modified from the Change Unit box. However, all design elements 
can be modified from the 3D view. 

1. From within the 3D view, click on the Options button. 

2. From the Options menu, click on Set Textures.  

3. From the Set Material Textures box, click on the Item to be customized. 

4. Click on Blend Color with Texture, to open the Set Colors box. 

5. From the Set Colors box, click on the default color group at the top of the 
box, or click on a color from the palette and the palette will change to hues 
within the color you selected. 

6. Once you have the color you want, click Set This Color and then click 
Close. 

7. You will be at the Set Material Textures box, Click on Close to apply 
changes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 



18 

 

Customizing Textures 
Textures can be applied, as well as colors, to enhance the look of your design.  
The texture materials can have color applied to them to further the customization 
and allow you to offer any combination to your customer. 

1. From within the 3D view, click on the Options button. 

2. From the Options menu, click on Set Textures.  

3. From the Set Material Textures box, click on the Item to be customized. 

4. From the Set Material Textures box, click on the texture type for example, 
Granite, wood, floor. 

5. Click on the specific texture from the list below the drop down menu. 

6. Click on Set This Texture, and then click Close to apply the changes. 

 

Customizing Counter Tops 
Counter tops can be customized in the same way that units, flooring and walls are 
customized. Some textures and colors can be blended to represent other types of 
counter top surfaces. There are textures for granite, Formica, wood and other 
materials to customize the counter tops.  Depending on the units you are using in 
the design, frame, frameless, or frame overlay, there is a default counter top group 
assigned. The default counter top can be modified to suit your overall design. 

1. From within the 3D view, click on the Options button. 

2. From the Options menu, click on Set Textures.  

3. From the Set Material Textures box, click on the counter top group to be 
customized. 

4. From the Set Material Textures box, click on the texture type for example, 
Granite, wood, floor. 

5. Click on the specific texture from the list below the drop down menu. 

6. Click on Set This Texture. 

7. If you see Blend Color with Texture, click on it to open the Set Color box. 

• If you see Replace color with texture, than the texture is applied “as is” 
without the color being blended with the texture. 

8. Click on Set This Texture, and then click Close to apply the changes. 
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Printing Your Design 
 
KCDw software allows you to print floor plans, elevations and 3D presentations of 
your design. In the trial version printing is disabled; please contact our technical 
support department at 508-760-1140 for assistance on printing designs from the trial 
version.  

 
Printing Floorplan and Elevation View 

From the File menu click on Print Drawing or press Ctrl P to open the Print box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Choose 1 or More Views – Selects the item(s) to be printed.  Click on view(s) 
to highlight or remove highlight. Only highlighted items will be printed. 

2. Options – Items to be included in print. A check mark includes that item on the 
print, for example a check next to Show Doors adds doors to the print.  

3. Color or Black & White – Prints the view in color or black and white. 

4. Dimensions – Selects the level of detail in the print, higher the number the more 
detail included. 

5. Printer Scale – Selects the scale of the print.  Auto scale fits the whole page.  If 
the selected scale does not fit on the page, only a portion of the design will print. 

6. Orientation – Selects the orientation of the print on the page, Landscape or 
Portrait. 
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 NOTE: Your design may contain walls with no units on them. The + symbol 
after a view in the Print box denotes a wall with units.  Select All Active 
Views will only highlight views with units, to include any inactive views, click 
on the desired view and it will be highlighted and included in the print. 

 

Printing 3D View. 
The option to print 3D line drawing or presentation view is only available from within 
the 3D view.  Before opening the Print box, position your design using the Move 
Camera and Move Picture.  In order to print the presentation view, the design must 
complete rendering in 3D presentation and visible on screen. 

From within the 3D view, prints of the design for either the 3D line drawing or 
presentation views can be printed. From the File menu click on Print Drawing or press 
Ctrl P to open the Print box.  The 3D print options are available from the Choose 1 or 
More Views section of the Print box.  The same options are available in the floor plan 
and elevation views Print box.  

 

 

 

 

 

 

 

 

 

Building a Page of Images to Print 
KCDw software allows you to print multiple images of the various views to a single 
page. From within any view, Click on File from 
the menu bar, click on Add This Drawing to 
Multi-Print.  The image, as it is viewed on the 
screen, will be added to the Multi-Print box. 

 NOTE: You can import pictures from other 
sources into the Multi-Print box. From the file 
menu, click on Import Picture into Multi-Print 
and a Browser box will open.  Select the 
picture you want to import and it will be 
added to the Multi-Print box. Several formats 
are supported including .bmp and .jpg. (Not 
in Trial Version) 
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Once you have added all the drawings that you want to the multi-print, from the file 
menu, click on Print Multi-Print Drawing and the Multi-Print box will open.  From the 
Multi-Print box Images can be dragged onto the preview page and arranged.  Clicking 
on the Image Borders checkbox will toggle on and off the frame box that appears 
around each image.   To resize an image, place the mouse pointer on the image.  
Then hold the Shift or Ctrl key and click the right or left mouse button.  

 

 

 




